Lookup

Type here the word that you want to look up in the WordWeb database.
When you have entered the word press Enter, or click on the Search button.



Previous Button

Press this button to look up the word that you last looked up.



Search Button

Press this button to look up the word in the Search Word edit box.



Show Nouns

Press this button to only show words that are nouns (or press Alt+N).
If the button is disabled it means there is no sense in which the word is a noun.



Show Verbs

Press this button to only show words that are verbs (or press Alt+V).
If the button is disabled it means there is no sense in which the word is a verb.



Show Adjectives

Press this button to only show words that are adjectives (or press Alt+A).
If the button is disabled it means there is no sense in which the word is an adjective.



Show Adverbs

Press this button to only show words that are adverbs (or press Alt+R).
If the button is disabled it means there is no sense in which the word is an adverb.



Sense descriptions
This box shows the different senses of the word you are looking up.

Different senses are numbered for each word type, nouns first, then verbs,
adjectives and adverbs.

See how to show synonyms by sense.



Showing synonyms by sense

Many words have more than one meaning, so when you lookup a word there many be more than one
definition displayed. To show just the synonyms specific to a particular sense, just click on the sense
number. Alternatively you can press TAB until the cursor appears in the sense section, use the cursor
keys to move the cursor onto the sense you want to view, and press ENTER.

For example if the search word is diffuse then your sense list would be

Verb: diffuse

1. move outward

2. spread or diffuse through
3. as of information

The synonyms include broadcast, disperse, spread out, permeate, etc. To show just the senses
corresponding to move outward, click on the '1'. You will then only see the synonyms fan out, spread
out and spread.

Click another sense number to select a different sense, or click the selected number to show all the
senses once again. The selected sense definition is shown in a different colour.



Showing synonyms by word type

The four buttons at the side of the definition box show whether the search word is a noun, verb,
adjective, or adverb, the most common word types. A button is grayed if the search word does not have
a meaning of that word type.

Click on one of the buttons to show only synonyms of that type, or use Alt+ the letter on the relevant
button. Selecting a word type is also a good way to quickly view the definitions for that word type.

To show all the synonyms again (regardless of type) just click on the button again.



Showing related words

The tabs at the bottom of the synonyms list box show the different available types of related word. Just
click on a tab to see words of that relationship, e.g. to see the antonyms of the search word click on the
tab that says Antonyms (if no such tab is present it means there are no antonyms in the database). You
can also see related words by pressing TAB until the tabs are selected and then using the cursor keys.

See Glossary of terms for explanation of the different types of related word.



Glossary of WordWeb terms

Synonyms Words which mean the same in some context
e.g. close is a synonym of shut.

Antonyms Words meaning the opposite in some context
e.g. big is an antonym of little

Attribs A noun for which the adjective expresses value
e.g. big is an attribute of size.

Type of Shows less specific words.
e.g. a comedy is a type of play

Types Shows more specific words.
e.g. flower has daisy as one of its types

Parts Shows words for part of an object
e.g. tree js one of the parts of a forest

Part of Shows words for a collection or the whole
e.g. bumper is a part of a car

Similar Words with meanings that are close
e.g. big is similar to huge
Copy

Press the copy button to copy the selected word to the clipboard.

If there is selected text in the definition section then that will be copied,
otherwise the word selected in the list box. If you are running WordWeb
from another program this button may close the window.



Close

Press this button to close the Word\Web window.



Tabs

Click on one of the tabs to show different sets of related words.

See glossary of terms for what the different words on the
tabs mean.



Synonyms list box

This show the synonyms of the search word, or other sets of related words indicated on the tabs at the
top.

Click on a word and press the Copy button to copy a word to the clipboard (or if you are using WordWeb
from a word processor to replace the looked-up word). Double click on an item in the list to look it up in
the database.

If WordWeb cannot match the part of speech of a word (for example if you look up plural noun WordWeb
may not know how to pluralize the noun collocations that appear as synonyms) the word will appear with
a star (%).



History list

Click on this to show the list of words previously searched for.

You can press the up and down cursors to move quickly up and
down the list without clicking this button. Press the Previous button
to return to the previous word.



Showing related words

WordWeb not only finds synonyms of words, but also a whole host of other words related in some way
to the search word. The different types of relation are explained in the glossary of terms.

When you first look up a word WordWeb displays the synonyms in the list box in the lower half of the
window. The other types of related word available are show in the set of tabs at the top of the list box.
Just click on one of these to show the related words of that type.



Options

There are three options on the Options menu - select one of them and a tick will appear by the menu to
show that you have that option selected.

Show roots only

By default WordWeb displays synonyms in the same part of speech as the search word, e.g. if you
search for hoped then it will display desired, expected, etc. If you select the Show roots only option it
will display desire, expect, etc. The root of the search word found in the database is displayed in the
sense descriptions. Select Show roots only to get the synonyms as they appear in the database.

If WordWeb cannot match the part of speech of a word (for example if you look up plural noun WordWeb
may not know how to pluralize the noun collocations that appear as synonyms) the word will appear with
a start (*).

The WordWeb part of speech matcher is good, but not perfect (for instance it can’t tell the difference
between collective nouns and ones that can be pluralized). If you want to be certain that you don’t
accidentally misuse words select Show roots only.

Stay on top

Select this option to make the WordWeb window stay on top of other windows so that you can always
see it.

Font

Select Small, Medium, or Large to change the font size used for showing definitions and synonyms.



Fonts

You can use WordWeb with three different font settings: small, medium and large. To change the font
size just select Font from the Options menu, and select the one you want.



Resizing the WordWeb Window
You can resize the WordWeb window by dragging the bottom right corner with the mouse.

The size of the window is saved when you close WordWeb so that it will start up the same size next
time.

If you change the window size you may also wish to change the window font.



Crossword Compiler

Crossword Compiler offers everything you need to make all kinds of crosswords, from simple
educational puzzles to complex cryptic crosswords. It can fill in blank grids, generate vocabulary puzzles
from a list of words, manage clues, print out, and lots, lots more! The program is used by many of the
world's best constructors and is recommended by Mel Rosen, author of the Random House
Puzzlemaker's Handbook. At the same time it is easy to use and suitable for beginners and
professionals alike.

Create vocabulary puzzles automatically

Automatic grid filling from word lists (supplied or make your own)
Create plain, barred, coded, clues in squares, skeleton and fill-in puzzles
Clue editor (with optional link-up to WordWeb Pro)

Clue database

Many export options for professional DTP

Powerful Word List Manager
These are just a few of the features, there is also a detailed feature list.

Ordering Crossword Compiler

Order Online at http://www.x-word.com/ordering.html
Ordering in North America

Ordering in Australia and New Zealand

Ordering in the UK and elsewhere.

For up-to-date information see the web pages at http://www.x-word.com/ or email to compiler@x-
word.com



Crossword Compiler features

For the latest program features, screen shots and sample output see the web pages at
http://www.netword.demon.co.uk/

Designing and editing puzzles

Create normal crosswords, barred grids, clues-in-squares puzzles, fill-ins, French-style crosswords,
coded grids, skeleton puzzles and free-form crosswords. Make any size up to 50x50, with automatic
numbering of grid squares. Color grid lines and squares, show hint letters in the puzzle, include graphics
in the grid, and lots more!

Grid filling

Fill in entire blank puzzles, or a particular section, with words from the supplied word list or one of your
own. Create thematic and pangrammatic puzzles automatically from word lists. Optimize the filling
process to use more 'good' words.

Create vocabulary puzzles

Type in a short list of words and get the program to build a crossword using as many of them as
possible. The computer places the black squares for you and tries to get as many intersecting words as
possible. Create freeform puzzles directly from a larger word list.

Finding words and anagrams

Quickly find words to fit in a slot in the grid. Search for words matching a pattern. Find multi-word
anagrams of words and all the words that can be made from the letters of another word. Search through
different word lists (including ones you've made yourself).

Writing clues

Find anagrams of the clue word. Look up cryptic abbreviations in the supplied, or your own, look up files.
Optional automatic word length after clues, with support for compound words and phrases. Use italic,
bold and underline in clues. Add explanations/citations to each clue. Facility to write joint clues (link
words in the grid together). Review and spell-check you clues.

Clue database

Add clues from puzzles, paste clues from the database into the clue editor, browse and edit the
database. Use clues that are most recent, oldest, or randomly.

Print out and export to other programs

Copy your puzzles to the clipboard or save to a file for use in other programs. Export puzzle, solution,
numbered solution, clues, answers and explanations. Export grids as picture or bitmap. Export for use
Crossword Maestro or Across solving software. Print out clues with answers for professional crossword
submissions.

Word List Manager

Simply view, edit and create word lists. List manipulations and conversions. Use different character sets
for multilanguage crosswords. Word lists can contain words from 2-50 letters long.

Customise most properties of the grid and clues

Change square sizes, size ratios, fonts, colours, line thickness, side numbering, clue numbering, clue
spacing, etc. Save settings and grids in template files for easy reuse.



Puzzle information and printout headers

Supply a title, author, copyright and description for each puzzle. Printout headers containing this
information or statistics for the puzzle. Customise the headers with different fonts, styles, etc.

Multilanguage support

Supports most Western languages. Create word lists with different Windows character sets (e.g. Cyrillic,
Turkish, East European, etc.)

Extensive context sensitive help

Find help related to what you are doing at the press of a button. The help file explains all the features of
the program, and tells you how to go about create the various types of puzzle.

Link up to dictionaries from the clue editor

Add buttons to the clue editor ToolBar so you can look up words in dictionaries. Smooth integration with
the WordWeb Pro thesaurus/dictionary add-on. The installation program automatically detects and sets
up a link to most popular dictionaries.

Optional extras

Sets of additional word lists are available, including foreign words, expressions, unusual words and
words in categories (see ordering in North America or ordering elsewhere for details). You can use these
lists for word finding, grid filling, adding to other lists, or basically whatever you like! WordWeb Pro
thesaurus/dictionary can be used from the clue editor or to look up a word in the grid.

System requirements
486 or higher PC running Windows 95, 98, NT4, or compatible higher version.



License Information

You may use WordWeb free of charge for whatever you like - | hope you enjoy the program.

The program is 'bannerware’ - | let you use it for free in the hope that you may be interested in my other
programs Crossword Compiler, WordWeb Pro and WordWeb Developer.

WordWeb may be freely distributed without royalty as long as it is distributed in the form of the original
unmodified self-extracting installation program. For some distribution purposes the installation program
may be zipped.

E-Mail: WordWeb@netword.demon.co.uk
Internet: http://www.netword.demon.co.uk/wweb/.

WordWeb is copyright © Antony Lewis 1998. All rights reserved.
WordNet database copyright 1997 © Princeton University. All rights reserved.

THIS SOFTWARE AND DATABASE IS PROVIDED "AS IS" AND PRINCETON
UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR
IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, PRINCETON
UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES OF MERCHANT-
ABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE

OF THE LICENSED SOFTWARE, DATABASE OR DOCUMENTATION WILL NOT
INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR
OTHER RIGHTS.



WordWeb Pro

WordWeb Pro offers some extra features:

Word searching facility
Enter a pattern as the search word and it will find words that match, e.g.

T??7?SH finds thrash, thresh and thrush
*GRY finds angry, hungry and unangry
7”Q*P finds acquaintanceship, equip, liquid soap, re-equip,

and square up

Use * to stand for any number of letters, ? for one unknown letter, @ for any vowel or # for a
consonant. You can also search for letter groups and do punctuation-sensitive searches. The huge
160,000 word database is searched very quickly.

Anagrams
Enter a word and you can find all straight and multiple word anagrams, e.g.

protest finds potters, spotter, to strep, pert sot, etc.
begin finds being, binge, in beg, and gin be.

WordWeb Pro finds powder brow + many others

Customize the dictionary
Add to and edit the dictionary. Add new words, add new senses, edit definitions, etc.

WordWeb Pro can also be integrated into Crossword Compiler if you wish to write crosswords.
ORDERING

Order Online - $18 US Dollars

Follow the link from http://www.x-word.com/wordweb/ordering.html.

Paying in US Dollars - $25 on CD-ROM.

You can order with MC, Visa, Amex, or Discover from Public (software)
Library in the following ways:

FAX: To 713-524-6398 ask for product #14213 and please type or block print very plainly.
Email: To PsL at 14213@pslweb.com
Mail:To PsL at P.O.Box 35705, Houston, TX 77235-5705, USA.

Phone: PslL's operators are available from 8:00 a.m. to 6:00 p.m.
Monday-Friday at 800-242-4775 Ext.14213 or at 713-524-6394 Ext.14213



THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
Please e-mail any questions to WordWeb@x-word.com

Paying in Pounds Sterling - £15 on CD-ROM

Print out an order form that you can fill in and post.

Payment is by cheque, Eurocheque or money order. If you don't have a Sterling cheque account you
can also pay by non-Sterling cheque for an equivelent amount plus a £4 handling charge. Alternatively
use one of the methods listed above under Paying in US dollars.

Paying in Australian Dollars - £39 on CD-ROM
You can order by phone, fax, email, postal mail or online.

Fax your order to (02) 9565-2362

Phone your orderto  (02) 9565-2339

Email your order to sales@shareware-australia.com

Order online at http://www.x-word.com/wordweb/ordering.html

Mail your order to: Shareware-Australia, PO Box 1075, Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, Visacard, or American
Express.

Payment in Euros

At the time of writing the Euro doesn't exist. Please see http://www.x-word.com/ordering.html for the
latest ordering information. Otherwise see under Ordering in Pounds Sterling.

Other methods of payment and enquiries

Please e-mail any questions to WordWeb@netword.demon.co.uk
Up to date information about WordWeb Pro can be found on the World Wide Web at
http://www.netword.demon.co.uk/wordweb/.



Crossword Compiler Order Form

Please select Print Topic from the file menu and then fill in the form. Send to:
Antony Lewis, 16 Townley Rd, London SE22 8SR, England.

Name:

Address:

E-mail:

Where did you get your copy of WordWeb from?

Please send me the following (put an 'X' for any you want):

___Crossword Compiler version 4.12 £28
__ WordWeb Pro 1.6 £15
__Crossword Compiler CD-ROM £55

(includes WordWeb Pro and all word

lists)

and the following additional word list sets for Crossword Compiler at £6 each

Disk

1:
___ Disk

2:
__ Disk

3:
___ Disk

4:
___ Disk

5:

Medical, legal, ethnic, names, food, US places, UK places, cities, literature,
Old Testament, IATA, Olympic, school chemistry, large list of unusual words
and variant spellings.

Words from Webster's second edition, expressions from Webster's second.
German, French, Spanish, Italian and Latin.

Finnish, Norwegian, Danish and Swedish.

UK Advanced Cryptics Dictionary: 210000+ words.

| enclose a cheque, Eurocheque or PO/International Money Order for a total of £
(please add £2 P&P if you are outside the EU and £4 if you wish to pay in another currency)

Signed:




Ordering Crossword Compiler in N. America

The following are available:

Crossword Compiler version 4.12 $45
Two disks of additional word lists (see below) $25
WordWeb Pro 1.6 $25
Languages word list: French, German, Italian and Spanish $12.50
UK word list: UK Advanced Cryptics Dictionary $12.50
Crossword Compiler CD-ROM (Includes all of the above) $89

The additional word lists consist of: unusual words and variant spellings, words from Webster's second
edition, expressions from Webster's second, medical, legal, ethnic, names, food, US places, UK places,
cities, literature, Old Testament, IATA, Olympic and school chemistry.

CREDIT CARD ORDERS

You can order with MC, Visa, Amex, or Discover from Public (software)
Library in the following ways:

Online: Follow the links from http://www.x-word.com/ordering.html.

FAX: To 713-524-6398 ask for product #11992 and please type or block print very plainly.
E-mail: To PsL at 11992@pslweb.com
Mail: To PsL at P.O.Box 35705, Houston, TX 77235-5705.

Phone: PsL's operators are available from 8:00 a.m. to 6:00 p.m.
Monday-Friday at 800-242-4775 Ext.11992 or at 713-524-6394 Ext.11992

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.
Please e-mail any questions to compiler@x-word.com).



Using WordWeb
Click on a part of the window to see a description of what it does, or select one of the following topics:
Showing synonyms by sense
Showing synonyms by word type

Showing other related words
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WordWeb Developer

WordWeb Developer contains two thesaurus/dictionary components for Delphi or C++ Builder. One is
very similar to WordWeb, just minus the menu bar. The other is a cut-down thesaurus only, useful
because it can be used with a much smaller database file. The full database is exactly the same as the
one used by WordWeb.

Highlights:
Two easy-to-use components
Large up to date database
Database customizer
Full source code for direct low-level database access
Works with Delphi 2, Delphi 3, C++ Builder 1 and C++ Builder 3

Database customizer:

Add to and edit the database

Create smaller databases containing a subset of the original (sizes from <1MB to >6MB)
Remove a custom list of words from the database

For up-to-date information see the web pages at_http://www.netword.demon.co.uk/wwdev/. There may
become available versions for other programming environments - please check the web pages.

Ordering
Order online at http://www.netword.demon.co.uk/wwdev/ordering.html.
CREDIT CARD ORDERS - US Dollars

You can order the components for $75 with MC, Visa, Amex, or Discover from Public (software)
Library in the following ways:

FAX: To 713-524-6398 ask for product #15571 and please type or block print very plainly.

E-mail: To PsL at 15571@pslweb.com
Mail: To PsL at P.O.Box 35705, Houston, TX 77235-5705.

Phone: PsL's operators are available from 8:00 a.m. to 6:00 p.m.
Monday-Friday at 800-242-4775 Ext. 15571 or at 713-524-6394 Ext. 15571

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.

Please e-mail any questions to wordweb@x-word.com).

CHEQUE ORDERS - Pounds Sterling



Please send a cheque for £49 to
Antony Lewis, 16 Townley Rd, London SE22 8SR, UK.

| can accept non-Sterling cheques, for which there is an extra charge of £4. Just work out what £53 is in
your local currency and send a cheque for that amount (it must be in a convertible currency).

AUSTRALIA AND NEW ZEALAND - Australian dollars
WordWeb Developer costs $125 from our Australian distributor Shareware-Australia.
You can order by phone, fax, email, postal mail or online.

Fax your order to (02) 9565-2362
Phone your orderto  (02) 9565-2339
Email your order to sales@shareware-australia.com

Order online at http://www.x-word.com/wwdev/ordering.html
Mail your order to: Shareware-Australia, PO Box 1075, Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, Visacard, or American Express.



Ordering Crossword Compiler in Australia and New Zealand

Crossword Compiler is available in Australia/New Zealand from our local distributor Shareware-Australia.

The following are available (prices in Australian dollars):

Crossword Compiler 4.12 $79
Two sets of additional word lists (see below) $39
WordWeb Pro thesaurus/dictionary $39
Languages word list: French, German, Italian and Spanish $20
UK word list: UK Advanced Cryptics Dictionary $20
Crossword Compiler CD-ROM (includes all of the above) $149

You can order by phone, fax, email, postal mail or online.

Fax your order to (02) 9565-2362
Phone your order to (02) 9565-2339

Email your order to sales@shareware-australia.com

Order online at http://www.x-word.com/aus.html
Mail your order to: Shareware-Australia, PO Box 1075, Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, Visacard, or American Express.
There is an order form that you can print out and send.

Additional word lists.

The two sets of additional word lists consist of:

174000+ Unusual words and variant spellings
233000+ Words from Webster's second edition
75000+ Expressions from Webster's second

Medical, legal and ethnic words. Lists of names, cities and UK and US place names. Words
relating to literature, food, the Old Testament, IATA, photography, school chemistry and the
Olympics.



Crossword Compiler Order Form

Select Print Topic from the file menu, fill in the form and mail your

order to:
Shareware-Australia, PO Box 1075, Maroubra NSW 2035, Australia

Payment can be made by Cheque, Money Order, Bankcard, Mastercard,

Visacard, or American Express.

Name:

Address:

Phone: Fax: Email:
Paid by Cheque/Money Order [ ] Credit Card [ ]

Credit Card No.

Expiry Date: Signature:

Please supply

___ copies of Crossword Compiler @ AU$ 79.00 each S
__ copies of set of additional word lists @ AUS 39.00 each $
___ copiles of UK Advanced Cryptics Dictionary @ AU$ 20.00 each S

copies of Foreign Language lists @ AUS$ 20.00 each $

(French, German, Spanish, Italian, Latin)

copies of WordWeb Pro @ AUS$ 39.00 each S

copies of Crossword Compiler CD-ROM @ AUS 149.00 each $
(Includes all of the above)



Postage & Handling FREE

Total



WordWeb Pro 1.6 Order Form

Select Print Topic... from the File menu and fill in the form to order by post.

Name:

Address:

E-Mail:

Where did you get your copy of WordWeb from?

Please send me a the following:

copies of WordWeb Pro 1.6 at £15 each £

| enclose a cheque, Eurocheque or PO/International Money Order for a total of
P&P if you are outside the EU and £4 if you wish to pay in another currency)

Signed:

Please make cheques payable to Antony Lewis and mail to:

Antony Lewis, 16 Townley Rd, London SE22 8SR, UK.

. (please add £2



Technical Information

WordWeb works through a Windows DLL that you can use from other applications By calling
procedures in the DLL you can pop up the WordWeb box from other programs.

If you wish to use WordWeb from your wordprocessor, say, you could write a macro to call the DLL
functions to display the synonyms of the word you have selected in the wordprocessor. See the Using
WordWeb from your word processor topic for how to use these. If you write a macro for other programs |
would be happy to add them to future versions of WordWeb.

Programmers: Look at hitp://www.netword.demon.co.uk/wwdev on the Internet for details of WordWeb
Developer.

For the programmers amongst you, here’s what the Borland Pascal/Delphi declarations for the DLL API
look like in case you want to write your own macros:

function ShowWordWeb(P:PChar; AParent:Integer):integer; {index 1}

Shows WordWeb with P as the search word, AParent as the parent window. If P is nil then WordWeb is
not initialized with any search word. Returns a handle to the WordWeb window. You must have AParent
non-zero or retain the return handle. It will then either close when you close AParent or, in the second
case, you can send it a message to close it.

function ShowModalWordWeb(InP,OutP:PChar; CloseOnCopy:Boolean; AParent:Integer):
Boolean; {index 2}

Shows WordWeb modally - i.e. it shows the window but waits for the window to close before returning.
InP functions the same as P in ShowWordWeb. OutP points to a buffer to contain any selected word
(the buffer should be 255 bytes long). CloseOnCopy determines whether the function returns with the
selected word when the user presses the copy button. If this is true, pressing Copy closes the window,
OutP contains the selected word and the function returns true. If WordWeb is closed by pressing Close
the function returns false.



Using WordWeb from your word processor

WordWeb can be used directly from some word processors. You just run a macro, which pops up
WordWeb showing synonyms for the currently selected word in your word processor. Pressing Copy
then replaces the word with the word you selected in WordWeb.

Using WordWeb from MS Word (95, 97 or above)

Copy the template file supplied with WordWeb to your Word startup folder. For Word 95 this is called
WORDWERB, for Word 97 and above it's called WWebVB. Find them in the folder to which you installed
WordWeb.

You can find where your Word startup folder is by opening Word, selecting Options from the Tools
menu and changing to the File Locations tab.

Once you've copied the template, just start Word and click on the button on the toolbar to show
WordWeb. Alternatively use the Alt+Ctrl+W keyboard shortcut, or look for the WordWeb... item on the
Tools menu. If the WordWeb toolbar does not appear try right clicking on the the toolbar and making
sure that the WordWeb item is selected to be visible.

Using WordWeb from Corel WordPerfect 7

You can use WordWeb from WordPerfect by using the WWebUK.wcm or WWebUS.wcm PerfectScript
macros supplied with WordWeb. If you are using the UK version then use the WWebUK.wcm macro, if
the US version use the WWebUS.wcm macro. To run the macro just select Tools | Macro | Play..., and
open the macro file. You can also assign the macro to a button or menu if you like — see the
WordPerfect Help for more information.

Observant users may notice a remarkable similarity between the data in WordWeb and the WordPerfect
thesaurus. The programs themselves are however quite different - | only discovered the ‘similarity’ by
accident!

Using WordWeb from Lotus WordPro

You can use WordWeb from WordPro by using the WordWeb.LSS LotusScript file supplied with
WordWeb. To show WordWeb just select Edit | Script & Macros | Run... and click Browse to open the
WordWeb.LSS script. You need WWEB32.DLL to use WordWeb from WordPro 96.

If you like you can assign the script to a tool button and save the script in your default WordPro
document so that you can always use WordWeb with the click of a button. See the WordPro help for
details of how to do this.






